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Software Version: 

Current software and documentation is available on our web site.  Some 

early units may require hardware modifications to use the latest software.  

Contact REF TEK if you have any queries on the compatibility of your unit(s) 

and the current software release. 

Notation Conventions 

The following notation conventions are used throughout REF TEK 

documentation: 

Notation Description 

ASCII Indicates the entry conforms to the American Standard Code for 

Information Interchange definition of character (text) information. 

Binary Indicates the entry is a raw, numeric value. 

Hex Indicates hexadecimal notation.  This is used with both ASCII characters 

(0 – 9, A – F) and numeric values. 

BCD Indicates the entry is a numeric value where each four bits represents a 

decimal digit. 

FPn Indicates the entry is the ASCII representation of a floating-point 

number with n places following the decimal point. 

<n> Indicates a single 8-bit byte.  When the contents are numeric, it 

indicates a hexadecimal numeric value; i.e. <84> represents 

hexadecimal 84 (132 decimal).  When the contents are capital letters, it 

represents a named ASCII control character; i.e. <SP> represents a 
space character, <CR> represents a carriage return character and <LF> 

represents a line feed character. 

MSB Most Significant Byte of a multi-byte value. 

MSbit Most Significant Bit of a binary number. 

LSB Least Significant Byte of a multi-byte value. 

LSbit Least Significant Bit (bit 0) of a binary number. 

YYYY Year as a 4-digit number 

DDD Day of year 

HH Hour of day in 24-hour format 

MM Minutes of hour 

SS Seconds of minute 

TTT Thousandths of a second (milliseconds) 

IIII Unit ID number 
  

 

n, nS nano, nanoSecond; 10-9 = 0.000000001 

u, uS micro, microSecond; 10-6 = 0.000001 

m, mS milli, milliSecond; 10-3 = 0.001 

K, KHz Kilo, KiloHertz; 103 = 1,000 

M, MHz Mega, MegaHertz; 106 = 1,000,000 

G, GHz Giga, GigaHertz; 109 = 1,000,000,000 

Kb, KB Kilobit, KiloByte; 210 = 1,024 

Mb, MB Megabit, MegaByte; 220 = 1,048,576 

Gb, GB Gigabit, GigaByte; 230 = 1,073,741,824 
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Related Manuals: 

 

130-SMA System Documents Number PDF file 

130-SMA Startup (Command Line) Doc-SMA-Ops 130SMA_startup.pdf 

Data Utilities Users Guide Doc-Datautils 130_utilities.pdf 

130-SMA Command Interface Number PDF file 

130 Cmd Line - Theory of Operations Doc-CmdL-Theory 130_CLtheory.pdf 

130 Cmd Line - Release Notes Doc-CmdL-Release 130_CLRN.pdf 

130 Cmd Line - Reference Doc-CmdL-Ref 130_CLcmd.pdf 

130 Cmd Line - Recording Format Doc-CmdL-Record 130_CLrecord.pdf 

130-SM GUI Users Guide Doc-130-SMGui RT130SM.pdf 

Optional Manuals Number PDF file 

SNDP Installation and Users Guide SNDP-OP-003 SNDPUser.pdf 

SNDP Reference Guide SNDP-S-002 SNDPRef.pdf 

RTCC Command / Control Users Guide RTCC-S-006 RTCC.pdf 

RT_Display Users Guide RTD-S-007 RTDisplay.pdf 

RT_View Users Guide RTV-S-005 RTView.pdf 

RTPMonitor Installation and Users Guide RTPM-S-008 RTPM.pdf 

RTPD Installation and Users Guide RTPD-OP-005 RTPD.pdf 

(part of RTPD manual) RTP Protocol   

Accelerometers   

131A-02/3 3G Triaxial Accelerometer Doc-131A-03/2 131A023.pdf 

131A-02/2 3G Triaxial Accelerometer Doc-131A-02/2 131A022.pdf 

131A-01/3 4G Triaxial Accelerometer Doc-131B-01/3 131B013.pdf 

131B-01/1 4G Unixial Accelerometer Doc-131B-01/1 131B011.pdf 
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REF TEK Support and update notifications 

As a valued user of REF TEK equipment we would like to 
provide the best support possible by keeping you up to 
date with our product updates. 

 

If you would like to be notified of any REF TEK product 
updates please spend a couple of minutes to register with 

the REF TEK customer support team. 

 

To register, enter your company information through the 

Register link on our website fill at http://support.reftek.com. 

 

Our support team will send you a unique Username and 
Password allowing secured access to all product 
documentation and software sold to you company. 

 

Once we register your contact we will only send necessary 
notifications via email. The same notifications will be 
shown on our website http://support.reftek.com notifications 
page . 

 

Thanks, 

Your REF TEK support team  

 

 

http://support.reftek.com/
http://support.reftek.com/
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1 Compass Overview 

1.1 About the Compass Program  

This program was designed to assist the operator of a seismic station to 

make an initial analysis of the station's waveform data quickly and to create 

a report of phase picks which can be forwarded to national and international 

data centers. 

 

Figure 1-1 About COMPASS 
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1.2 Contact for questions and suggestions 
 

Refraction Technology, Inc. 

1600 Tenth Street, Suite A 
Plano, Texas 75074 

USA 

 

Voice: 214-440-1265 
Fax: 972-578-0045 

EMAIL: support@reftek.com 

FTP: ftp.reftek.com 

WWW: http://reftek.com 

Supported Platforms  

Windows 2000  

Windows XP  
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1.3 Installation Guidelines 
 

1. Copy the COMPASS CD folder to the c:\reftek folder on the Hard Disk. 

2. Create a desktop shortcut for Compass and place on the desktop. 

1.4 Pre-Requisites 

Acquisition systems usually store waveforms in some specific formats. 

Usually they are in raw digital counts.  

To get full performance with COMPASS software it is strongly recommended 

to have each station-channel’s information:  

 Location of Sensor (Latitude, Longitude, Altitude, and Depth in the Vault)  

 Sensor orientation (Azimuth and Dip)  

 The azimuth of the instrument in degrees from north (clockwise).  

 The dip of the instrument (down from horizontal).  

 The traditional orientation :  

- Z -----------------------Dip = -90,Azimuth = 0  

- 0 N -------------------- Dip = 0,Azimuth = 0 

- 0 E ---------------------Dip = 0,Azimuth 90  

 Channel Transfer Function: Look Up Units 

(Meter,Meter/Second,Meters/(Second^2)  

 Complex Poles, Zero of Transfer Function and Channel Sensitivities  

 Optional information about FIR filters & decimating stages  

The program is usually trying to locate a Dataless. Network_Station.seed file 

in the Response folder and then read this info in memory.  

Note: If you are familiar with fields in the 
http://www.iris.edu/manuals/SEEDManual_V2.4.pdf there are some extra hints 

to load such info from general ASCII files. 
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1.5 Loading RAW REF TEK data 

To prevent program problems while loading raw data, it is recommended to 

use of the arcfetch program on the RAW reftek data. 

WARNING: This program uses Volt per Unit, Bit Weight and Station 

Location from the EH packet. If this information is missing there may 

be limited results. 

1.5.1 Using the New Trace and Add Trace menus 

1. To bring data into the program for analysis, select the New Trace menu item  

                -OR-  

2. Use the hot key n. 

 
                Figure 1-2 Bring in data 

3. The Open files dialog box opens. 

 
                  Figure 1-3 Open dialog box 

4. Set the Open dialog option Files of Type set to REFTEK (*.*). 
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1.6 To Process REF TEK Data 

1.6.1 Create a DAS *.rtu file in the Response folder 

Compass looks in this file which will contain values missed from the EH 

header and are read by the Compass program (DAS = DAS unit ID). 

1. Open the example.rtu file found in the Response folder with an editor. 

2. Update desired settings. 

3. Save the file in the rtDAS.rtu format. 

 
                  Figure 1-4 Example .rtu file 
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1.6.2 Process data when loading an acceleration record 

Example steps used to process are: 

1. Create the rtDAS.rtu file for each DAS and save in the Response folder (Created 

in Section 1.6.1). 

2. Load the RAW RT files that have the Acceleration included. 

 
                  Figure 1-5 Load New Trace 

                
                 Figure 1-6 Load the RAW RT files 

3. Select the channels of interest. 

4. Approve the picked traces with the OK button. 
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5. The new traces display on the screen. 

 
                  Figure 1-7 New Traces 

6. Remove the DC-Offset (if the Linear drift polinom = 1) by selecting the Remove 
Offset > Polinom Removal men. 

 
                  Figure 1-8 Remove DC Offset 
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7. The option dialog box opens for DC-Offset. 

8. Set the Polynominal Degree to 1. 

9. Approve the setting with the OK button. 

 
                  Figure 1-9 DC-Offset Degree 

10. The screen redraws to show the completed offset operation. 

 
                  Figure 1-10 DC-Offset 

 

Note: To see the units in a display in Gs go to the View menu and select the 

Acceleration processing option to show labels in Gs. 
 

Note: To calculate max path and period from an acceleration record refer to the 

Auto A/T command “Pick A/T ”. 
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1.6.3 To go from Acceleration to Velocity: 

1. Apply the Taper menu command to decrease the side effects of the filters. 

 
                   Figure 1-11 Taper 

2. To use the Taper command pick points to taper at each end 

3. The results of the taper operation are shown below: 

                
                 Figure 1-12 Taper completed 
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4. Use a BandPass filter IIR Butterworth (Bidirectional for no phase error) 

 
            Figure 1-13 BandPass 

 

5. The option dialog opens to set the filter options. 

6. Select the Bidirectional check box. 

 

7. Approve the settings with the OK button. 
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      Figure 1-14 Bidirectional 

8. Integrate by selecting the Trapezoidal command to get the Velocity. 

(Trapezoidal is a common integration formula in BAP processing). 

 
      Figure 1-15 Trapezoidal 
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9. The result displays on the screen. 

 
     Figure 1-16 Velocity results 
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1.6.4 To go from Velocity to Displacement: 

1. To remove  DC-Offset from the Velocity select the Time-Domain -> Remove 

Offset -> Polinom Removal command. 

 
                 Figure 1-17 Remove DC Offset 

2. The option dialog box opens for DC-Offset 

3. Enter “1” in the DC-Offset-Removal dialog box. 

4. Select the OK button to approve the DC Offset. 

 
                  Figure 1-18 DC Offset dialog 
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5. The results display on the screen. 

 
                  Figure 1-19 DC Offset applied 

6. Integrate to get displacement by using the Trapezoidal menu. 

 
                  Figure 1-20 Integrate 
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7. The results display on the screen. 

 
                  Figure 1-21 Displacement 

8. To remove DC-Offset from the Displacement select the Time-Domain > 

Remove Offset > Polinom Removal command. 

 
                  Figure 1-22 Remove Offset 
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9. The option dialog box opens for DC-Offset. 

10. Enter “1” in the DC-Offset-Removal dialog box. 

11. Select the OK button to approve the DC Offset. 

 

12. The results display on the screen. 

 
                 Figure 1-23 Displacement Results 

13. Use the Auto F/T menu command for automatic period and amplitude. To see all 
plots a window will open. 
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1.6.5 To select channels and compare what is in memory 

1. Use the Select Channels menu. 

 
                 Figure 1-24 Select Channels 

2. The display opens to select the channels. 

3. Approve the selection with the OK button. 

 
                  Figure 1-25 Select Previous Channels 
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4. The display updates to show the selected channels. 

 
                 Figure 1-26 Display Selected Channels 
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1.7 How to get SEED data 
 

1.7.1 First Method 

1. Follow instructions on www.iris.washinpton.edu WILBER  

1.7.2 Second Method 

2. Internet login to gsn station 

 

Example: 

1. Run telnet dp.emsd.iks.ru 

2. Follow the screen instructions. 

 Here is Example: 

 

** ** ** ** ** ** ** ** ** ** ** ** ** *First Stage** * *** * *** * *** * ***  

05-9/68K V2.4 Motorola VME147 -68030 101/12/13 01:54:47 

 

User name?: seed 

Password: data 

Process #30 logged on 101/12/13 01:55:00 

Welcome! 

 

• .please wait 

 

PET - MultiShear ~***LOCATION CODES REQUIREDH*** (Use R command) 

 

Please type your name and organization - up to 50 characters: 

** ** ** ** ** ** ** ** ** ** ** ** ** ** ** ** ** ** ** ** ** ** ** ** ** 

User 

PET - MultiShear ~***LOCATION CODES REQUIREDU*** (Use R command) 

Copyright 1986-1998 by Joseph M. Steirn & Quanterra, Inc. 

Retrieve (C) 1986-1998 - MSHEAR Release 36/08-0131- 68020- FPU 

type ? for help 

Command? V 00-Bil? 

UTC starting date for PET.00-BH? data: 

yy/mm/dd hh:mm:ss 

? 2001/12/01 00:00:00 

UTC ending date for PET.00-BH? data: 

yy/mm/dd hh:mm: ss 

? 2001/12/01 00:05:00 

...search interval 2001/12/01 00:00:00 - 2001/12/01 00:05:00 

9 total records selected. 
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...creating local file 

writing local file 

•..creating archive file “CHOl 1201.A00” 

BHN-1 1/30 23:58* , BHZ-1 1/30 23:58* , BHE-1 1/3023:59*, BFIN-12/Ol 00:00* 

BHZ-l2/01 00:00*, BHE-l2/Ol 00:01* , BHN-12/Ol 00:03*, BHZ-12/01 00:03* 

BHE-l2/Ol 00:04* 

•...closing local file 

Command? q 

• . .normal termination 

•..vbb data retrieval system logged out 

** ** ** ** ** ** ** ** ** ** ** ** ** *Second Stage* *** * *** * *** * *** * 

Run ftp dp.emsd.iks.ru & follow screen instructions 

Connected to dp.emsd.iks.ru. 

220 05-9 ftp server ready 

User (dp.emsd.iks.ru:(none)): ftp 

331 password required for fip 

Password: user 

230 user fip logged in 

~ binary 

200 Type set to I. 

fip> get cbOll2Ol.aOO 

200 PORT command ok 

150 Opening data connection for cbOll2Ol.aOO ( 194.84.170.1 15,25 13) (36864 

bytes) 

 

226 Transfer complete 

36864 bytes received in 25.11 seconds (1.47 Kbytes/sec) 

ftp> del CB011201.A00 

200 DELE command ok 

ftp> by e 
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1.7.3 Third Method 

Connection to netreg process on DP 

Run reqd.exe 

Input Password :DATREQ 

Input PortName(ex. operator) :4003 

Input HostName(ex. rts2) :dp.emsd.iks.ru 

Input Packet Size(ex. 4096) :4096 

Input Channel Maska (cx. 00-BHZ):00-BHZ 

Input StartDate(ex. YYYY/MMJDD) :2001/12/01 

Input StartTime (cx. HH:MM:SS):00:00:00 

Input Duration in Sec (cx. 360):600 

 

This will generate a file with data on Your local disk named: 

2001 1201-00-00-00.dp.emsd.iks.ru 

 

 

1.7.4 Create batch file request.bat with the text inside (cx.) 
 

reqd.exe DATREQ 4003 dp.emsd.iks.ru 4096 00-BHZ %l %2 %3 

reqd.exe DATREQ 4003 dp.emsd.iks.ru 4096 00-BHN %l %2 %3 

reqd.exe DATREQ 4003 dp.emsd.iks.ru 4096 00-BHE %l %2 %3 

 

1. At the command line:  

 

Run “request.bat 2001/12/01 00:00:00 600” 

 

2. This will generate a file with data on your local disk named: 
 

2001 1201-00-00-00.dp.emsd.iks.ru with three components inside. 

1.7.5 MINISEED 

If you are getting MINISEED data files You need to get dataless SEED files 

with response information inside: 

1. Goto ftp://aslftp.cr.us~s.gov/pub/dataless 

2. Download file (cx.) DATALESS.IU_PET.seed to the RESPONSE directory. 
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2 Using the File Menu 

2.1 File Menu menu 

A new analysis session begins by reading waveform data into program 

memory. Waveform data can be obtained from several sources in different 

formats. 

 

Figure 2-1 File Menu 
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2.2 New Trace Command 

Waveform data may be obtained from several sources, but must be in the 

FULL-SEED or MINI-SEED format. 

Every time a trace is altered by filtering or component rotation or the 

corresponding comment is added to the channel name the original trace is 

saved in memory. It can be recovered using this command. 

1. To bring data into the program for analysis, select the New Trace menu item  

           -OR-  

      Use the hot key n. 

    

2. The OPEN files dialog box opens. 

 
                 Figure 2-2 New Trace 

3. Select the desired channel components. 

 -OR- 

 Use Shift, Ctrl & mouse keys to highlight the components  

4. Select the Open button. 
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5. To arrange the traces in the display by different criteria, click the corresponding 

check box.  

6. To delete unnecessary channels from program memory highlight the channels 

and click the Delete button. 

 
                 Figure 2-3 Select Channels 

 

7. The desired trace(s) will display. 

 
                 Figure 2-4 Display Trace    
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2.2.1  Add Trace  

1. Additional data channels (which can be from different stations) can be read by 

selecting the Add Trace menu item  

          -OR-  

          Using the hot key a. 

2. The dialog box shown below appears. 

 
                  Figure 2-5 Add Trace 

3. To select MULTIPLE files press the Ctrl+Left mouse button. 

4. To select NON-CONTIGUOUS files select a single file and then press Shift+Left 
mouse button to select the last file of a contiguous selection. 

5. Click the cursor on the OPEN button to open the files. 

 
                  Figure 2-6 Select Additional Trace 
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6. Select the desired channels 

 

7. Press the OK button. 

2.2.2 Print a hard copy 

1. To get a hard copy of current screen select the Print menu  

          -OR-  

          Use the hot key p. 

          
                 Figure 2-7 Print Menu 

2. Fill in print dialog parameters and properties for the desired page layout. 

3. Select the OK button to plot the trace. 

 
                  Figure 2-8 Printer Setup 
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2.2.3 Save Data  

All active channels on the screen can be saved to one ASCII file within a 

(zoomed in) time interval for future use. 

1. Select the File menu Save Data option. 

 
      Figure 2-9 Save Data 

2. Select the desired type of data to save (ascii - *.asc or SeismoSignal - .dat). 

 
      Figure 2-10 Save as 
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2.2.4 To load previously saved ASCII files into the program: 

1. Using the New Trace or Add Trace commands when data has been loaded will 

result in a menu warning of erase of the data in memory. 

 

2. Use of the New Trace and Add Trace menus with the open dialog option will 

allow the Files of Type to be set to the desired filetype *.asc. 

 
                  Figure 2-11 Load Previous 
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3. Select the desired ASCII file. 

 
                  Figure 2-12 ASCII File 

4. Select the channel options and the channels. 

          -OR- 

5. Use Shift, Ctrl and mouse cursor to highlight the components. 

 

6. Press OK then done.  
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If a trace is altered by filtering, component rotation, or the corresponding 

comment is added to the channel name the original trace is saved in 

memory. It can be recovered using this command.  

1. To arrange the traces on the display by different criteria, click the corresponding 

check box.  

2. To delete unnecessary channels from program memory highlight them and click 
Delete button. 

 
                  Figure 2-13 Select Channels 

3. The desired trace opens in the display. 
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2.2.5 Exit  

1. Click on the box in the upper right corner of the window,  

          -OR- 

          Use the hot key combination Ctrl-X. 

        
              Figure 2-14 Exit Program 
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